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FINRA’s Examination & Risk Monitoring Program
2025

=Third-Party Risk Management- NEW
=Comprehensive Vendor Inventory

=Contingency Plans
=\Vendor Evaluation
*Enhanced Cybersecurity Focus- NEW
*New Quantum Computing Risks
=QR-Code phishing attacks
=Generative Al-enabled Fraud
*Reg Bl Compliance
=Increased Attention on Complex Product Recommendations
*Rollover Recommendations and Account Switch Focus
=Senior Investor Protection-

=Trusted Contact Persons
*Implementing Temporary Holds for Financial Exploitation




Four Pillars of LPL’s Audit Program

Books & Records Requirements

Branch Office Security, IT & Business Continuity

Disclosure Requirements

Account & Transaction Documentation



https://rc.lpl.com/content/rc/departments/operations/faq/faq-s---regulatory-and-advocacy---books-and-records.html?fromsearch=books%20and%20records%20policy
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-office-security-policy.html?fromsearch=branch%20office%20security%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/mrr-brokerage-and-advisory-disclosure-guide.html?fromsearch=disclosure%20requirements

Getting Started

= When to Expect a Branch Exam
» Non-OSJ Location: An audit examination of all Non-OSJ offices is conducted every three years.
» Satellite Location: An audit examination of all Satellite locations is conducted at least every three years.

» Starting September 2022, LPL is returning to limited on-site inspection schedule.

» Exams may happen more frequently based on previous findings and overall branch risk assessment.

= Location, Location, Location

» If you are the branch manager or person in charge, you are responsible for the books and records maintenance as well as ensuring
the any other individuals at that location are properly situated.

» Make sure your location is registered properly. Is it a Non-OSJ Location or a Satellite (appointment only) location? You may need to
be registered at more than 1 location.

» Make sure all licensed and unlicensed staff are properly affiliated and accounted for.
» Quick office setup guide is available in the Resource Center in ClientWorks.

= Required Office Identification
» SIPC Sticker or Plaque.
» DBA Signage requirements (customized identification and signage must be pre-approved).
» Proper LPL Signage to include disclosures.
» Signage and SIPC Sticker must be prominently displayed at entrance to office/lobby.




Exam Ratings

Old Rating System New Rating System Definitions

Satisfactory Meets Expectations No deficiencies were identified or internal control systems are designed
and operating effectively.

Satisfactory / Needs Improvement Meets Most Expectations Internal controls systems require some review. Control processes are
designed but require some corrective action.

Needs Improvement Moderate Improvements Needed Internal controls systems need to be improved. Control processes are not
established and/or operating at an expected level of consistency, and
require corrective action.

Unsatisfactory Major Improvements Needed Internal control systems are not functioning as intended. Corrective action
and management involvement/monitoring are needed until control
deficiencies are remediated.
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Books & Records

= Create and preserve, in an easily accessible place, originals of all communications received and sent relating to their
“business as such”

= Review of correspondence, internal communications (e.g., emails, instant messages, text messages, chat messages,
interactive blogs).

» Qutside Business Activities and Private Securities Transactions
» Prompt disclosure

» Prior approval
> PS'I]'c where the associated person has or may receive selling compensation must record and supervise the transaction as if it were executed on behalf of
the firm.

= Regulatory Events Reporting
» Prompt disclosure — Rep to firm — Firm to FINRA

» Violations of securities laws and FINRA rules, certain written customer complaints, certain disciplinary actions the firm takes and certain internal
conclusions of violations, specified criminal actions, civil complaints and arbitration claims.

> This obligation applies to all member firms, including those that permit staff to use a non-firm or third-party digital communications channels to
conduct firm business.

= Mobile Apps & Digital Communications Channels
» Information is accurate, complete, and non-biased. (Fair and Balanced)

» Protocols for video/livestream/public appearance usage
» Capture/Review/Archive



https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=correspondence
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/outside-business-activities.html?fromsearch=outside%20business%20activities%20(oba)%20-
https://rc.lpl.com/content/rc/departments/grc/product-supervision-/PrivateSecuritiesTransactionsObligationsReminder.html?fromsearch=private%20securities%20transactions%20obligations

Books & Requirements

=L PL will review iDoc records in ClientWorks to confirm that all required Books and Records folders have
been created, and that all required forms are on file.

=Create all the pertinent files for your locations, even if they are empty.

=See the Branch Exam Record Keeping Requirements or Compliance Quick Start Guide for Office Set-Up for

more information.



https://rc.lpl.com/content/rc/technology/idoc-user-guide.html?fromsearch=idoc
https://rc.lpl.com/content/rc/departments/grc/branch-exams-/RecordKeepingReqsforBranchExams.html?fromsearch=branch%20exam%20readiness%20|%20record%20keeping%20requirements

Books & Requirements

- Client Files
» All branch files must be secured and kept in ClientWorks using LPL’s iDoc Feature.
» All client files must be secured and kept in ClientWorks using LPL’s iDoc Feature.
» No physical (paper) files should be maintained.

- Books & Records (Must be maintained for each Registered Branch Location)
» Check Receipt Log

» Advertising File

» Sponsor Approved Advertising File (if applicable)

» All versions of Business Cards, Letterhead and Envelopes (used by everyone in this branch office)
» Incoming Correspondence — Brokerage

» QOutgoing Correspondence — Brokerage

» Complaint File — Brokerage

» Complaint File — Options

» Complaint File — Commodities (if applicable)

» Do Not Call List

» Signature Guarantee Log (if applicable)

» Cash/Non-Cash Compensation Log

» Daily Deposit Report (if using local deposit program)
» Remote Deposit Check File (if applicable)

» Non-Local Deposit Check Log



https://rc.lpl.com/content/rc/technology/idoc-user-guide.html?fromsearch=idoc
https://rc.lpl.com/content/rc/technology/idoc-user-guide.html?fromsearch=idoc
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/check-receipt-report-for-non-local-deposit-program-checks-f474&fromsearch=f474
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/check-receipt-report-for-non-local-deposit-program-checks-f474&fromsearch=f474
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/departments/grc/supervisor-osj-program-manager-information/osj-manager/Correspondence-FAQ.html?fromsearch=brokerage%20correspondence
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=check%20reciept%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=check%20reciept%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=check%20reciept%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=check%20reciept%20log

Books & Requirements

= Books & Records (Cont.)
» Securities Receipt Log

» FINRA Manual (or web access)

» Operations Manual and Compliance Manual (or access to Resource Center)

> Client Files
> Prospectus Delivery Log

> Branch Office Business Continuity Plan

= |f Transacting Advisory Business:
» Advisory Advertising File
» Advisory Complaint File
» Advisory Incoming Correspondence File
» Advisory Outgoing Correspondence File

= |f Registered with the SEC or the state as a Registered Investment Advisor:
» RIA Advertising File
» RIA Complaint File
» RIA Incoming Correspondence File
» RIA Outgoing Correspondence File
» RIA Ledger of fees Billed/Received



https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/securities-receipt-log-f473&fromsearch=securities%20reciept%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/securities-receipt-log-f473&fromsearch=securities%20reciept%20log
https://www.finra.org/rules-guidance/rulebooks
https://www.finra.org/rules-guidance/rulebooks
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/manuals.html?fromsearch=compliance%20manual
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/manuals.html?fromsearch=compliance%20manual
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=securities%20reciept%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=securities%20reciept%20log
https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp
https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp

iDoc

=iDoc is required to be used for storage of client related and
branch level documents.

» Drag & Drop or easily browse to upload your documents.
» Upload multiple documents at a time.
» Customizable ways to categorize documents.

» “Advisor” and “Branch” document categories that allow you to go
paperless while still being SEC compliant (i.e., compliance Files,
Advertising files).

» Documents on Demand — ability to request all of your imaged
forms on an external hard drive for a cost of $200.

> See the iDoc Paperless Office Solutions Reference Center in the
Resource Center for more information.



https://rc.lpl.com/content/rc/technology/idoc-user-guide.html?fromsearch=idoc
https://rc.lpl.com/content/rc/technology/idoc-user-guide.html?fromsearch=idoc
https://rc.lpl.com/content/rc/technology/iDoc_-_Paperless_Office_Solutions.html?fromsearch=idoc

File Tips

= Prospectus Delivery Log
» You must deliver a prospectus for direct mutual fund business, including 529 Plans and Structured Products.

» Prospectus delivery must be logged on the F631 form.

= Check Log
» If you are receiving checks at your branch and not using mobile deposit, use the F474 form to log receipt.

= Make sure you keep copies of the checks along with the log, front and back.

> If you are using the remote deposit app, there is no need for you to also maintain the F474.
= Please keep client checks for 3 weeks to make sure the checks clear properly.
= Destroy/shred checks after 3 weeks.

= Non-Cash Compensation Log
» Any qifts given to or received from clients must be submitted in the MyComplianceOffice portal.

» Any time you go to dinner, drinks, a ball game, etc. that is paid for by a product sponsor/wholesaler, you must assign an
estimated value to it and is required to be logged in the MyComplianceOffice portal.

» Complaint Files
> Itis the rep’s responsibility to report complaints to the OSJ as soon as they are received.
» Failure to report a complaint in a timely manner will be cause for disciplinary action.



https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=prospectus%20delivery%20log%20f631
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=prospectus%20delivery%20log%20f631
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/check-receipt-report-for-non-local-deposit-program-checks-f474&fromsearch=f474
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/check-receipt-report-for-non-local-deposit-program-checks-f474&fromsearch=f474
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/check-receipt-report-for-non-local-deposit-program-checks-f474&fromsearch=f474
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=non%20cash%20compensation%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=non%20cash%20compensation%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compensation/non-cash-compensation-log-f151d&fromsearch=non%20cash%20compensation%20log

Electronic commmunications:

Continued Focus in 2025

$600 Million in fines in 2024

Legal hold notice

Recent regulatory fines/suspensions

Approved channels only

LPL $50M Settlement



https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications.html?fromsearch=electronic%20communications
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications.html?fromsearch=electronic%20communications

Communication with the

Electronic Communications & Social Media

= All LPL associated persons are required to use an LPL Financial email address, or the advisor’s compliance-
approved proprietary Doing Business As (DBA) domain email address hosted with an LPL Financial-approved
email host vendor.

= The use of generic email address such as Yahoo, Hotmail, and Gmail are strictly prohibited.

= Email signatures must be submitted to Marketing Regulatory Review (marketing@lplatfrg.com) for
review and approval.

= |f any form of electronic communications you would like to use is not being captured, reviewed, and archived by
LPL, then you cannot use it

= Text messaging is forbidden unless when using LPL's MyRepChat Application. No other application for text
messaging is allowed or approved by LPL. There is no charge for this technology.

= The use of Social Media (LinkedlIn, FaceBook Business, Twitter) to market your brand is allowed, but you must:
» Take the required training in the Learning Center — Social Media Training
» Submit your Social Media Onboarding Form in ClientWorks

> Sign up for Social Patrol, a monitoring service ($85/yr)



https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications/electronic-communications.html?fromsearch=electronic%20communications%20policy
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/social-media-user-guide.html?fromsearch=social%20media%20policy
https://rc.lpl.com/content/rc/departments/technology/myrepchat.html?fromsearch=my%20rep%20chat

Social Patrol

= Getting Started with Social Patrol

= How to check if your Account(s) are Connected to Social Patrol

= LinkedIn
» Click your profile icon labeled “Me”

» Settings and Privacy
» Data Privacy
> Permitted Services — Social Patrol should show here if connected

= Facebook
» From your Profile, click the options button in the right corner of the menu bar (small downward arrow), and choose Settings
» Choose business Integrations from the menu on the left
» In the Active tab, Proofpoint Social Patrol will be listed
= Twitter
» From your Account Info or Profile menu, choose Settings & Privacy (you may have to click the More menu button to show this option)
» In the Settings section, click Account
» In the Data and Permissions section, click Apps and Sessions

» In the Apps section, Proofpoint Social Patrol will be listed



https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/getting-started-with-social-patrol.html?fromsearch=social%20patrol%20getting%20started%20guide
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/getting-started-with-social-patrol.html?fromsearch=social%20patrol%20getting%20started%20guide

Consolidated Reporting

=A consolidated report—Ilike account summaries, performance reports, and statements of
holdings—is any document provided to or on behalf of a client, in any format, that contains a full or
partial list of financial assets, regardless of where those assets are held.

*Depending on criteria defined in this policy, most advisors must use an approved consolidated
reporting tool—LPL Client Reporting, Albridge Wealth Reporting, Black Diamond® Wealth
Platform, Fortigent, Orion Advisor Services, or Portfolio Review Report—to create and share those
reports. See Consolidated Reporting Requirements and Guidelines for more information.

=Consolidated Reporting Policy Overview



https://rc.lpl.com/content/rc/technology/client-reporting-reference-center.html
https://rc.lpl.com/content/rc/technology/Albridge.html
https://rc.lpl.com/content/rc/technology/black-diamond-wealth.html
https://rc.lpl.com/content/rc/technology/black-diamond-wealth.html
https://rc.lpl.com/content/rc/tools/fortigent.html
https://rc.lpl.com/content/rc/technology/OrionAdvisorServices.html
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/consolidated-reporting-requirements-guidelines2.html
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/consolidated-reporting-requirements-guidelines2/consolidated-reporting-policy.html?fromsearch=consolidated%20reporting%20policy
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/consolidated-reporting-requirements-guidelines2/consolidated-reporting-policy.html?fromsearch=consolidated%20reporting%20policy

Branch Office IT & Business Continuity

= LPL will check to confirm that your Branch Office Business Continuity Plan is updated and tested annually.

= LPL will confirm that all devices used to conduct LPL business are compliant with LPL’s Branch Office
Security Policy.

= The FRG IT department can be contacted at IT@Iplatfrg.com.



https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-office-security-policy.html?fromsearch=bosp
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-office-security-policy.html?fromsearch=bosp
mailto:IT@lplatfrg.com

Branch Office IT & Business Continuity

= Branch Office Security Policy (BOSP)
» All devices used to conduct LPL business must be compliant with LPL’'s BOSP.

» The BOSP can be found in the Resource Center in ClientWorks.
» Test the security standards of your computers.

» You can use the Security Standards Testing Worksheet, found in the Resource Center to test for compliance with this policy
yourself, or contact the FRG IT department at IT@Iplatfrg.com, who will test on your behalf.

= Email Usage

» NEVER use a personal email address for any type of business purpose, no matter how harmless you think the usage may
be. LPL will perform an email search to check for personal email usage.

» Do not forward articles, client info, or communicate with clients to/from your personal email address. Sign in and use your
LPL webmail at home if/when necessary.

» If you are using an institutional or DBA email address, LPL must either host it or capture it via the journaling tool.

» If you are an institutional rep or bank employee that has both and LPL and bank email address, make sure you are using
each one correctly. (Do not use your bank email address for LPL business if it is not being captured/journaled).

= Branch Office Continuity Plan (BCP)
» Every office location is required to maintain a Branch Office Continuity Plan.

» A highlighted, fillable template is available in the Resource Center. Included in the template is a testing worksheet that you
must complete and attest to every year.

> Itis REQUIRED that your BCP is updated and tested annually.



https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-office-security-policy.html?fromsearch=bosp
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-office-security-policy.html?fromsearch=bosp
mailto:IT@lplatfrg.com
https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp
https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp
https://rc.lpl.com/content/rc/departments/grc/business-security-/branch-office-security-policy-/LPL_Financial_Branch_Office_Continuity_Plan_Template.html?fromsearch=bcp

Branch Office IT & Business Continuity

= Document Signature Policy
» Non-genuine signature-use of white out, cutting, pasting, and maintaining blank signed documents.

» Incomplete signed document are considered “blank signed document” and will result in an audit finding, and could include a
letter of caution and fine.

= Client PII

» Sharing of client PII to non LPL affiliated Financial Institution employees is strictly prohibited.

= Accepting Trade Orders via Email, Voicemail, Text, or Fax from Clients
» All trade or money movement orders must be confirmed verbally.

» E&O insurance will not cover instances in which the rep fails to verbally confirm orders or money movements.

= Electronic Communication (Chat Rooms/Forums, Instant Messaging, Texting, etc.)

» You are only allowed to use forms of electronic communications that LPL is able to capture, review and archive.

» Text messaging can be used ONLY with the MyRepChat Application. No other application for text messaging is allowed or
approved by LPL.

» Instant Messaging is only available using the Slack application.



https://rc.lpl.com/content/rc/departments/grc/business-security-/electronic-communications.html?fromsearch=electronic%20communications
https://rc.lpl.com/content/rc/departments/technology/myrepchat.html?fromsearch=myrepchat

Disclosure

LPL will confirm that all required disclosures have been made regarding:
Marketing Review
Outside Business Activities
Outside Securities Accounts
Private Securities Transactions
Social Media Usage
Customer Complaints

Liens

Criminal Activity




Disclosure

= Qutside Business Activities

» Outside business activities include any business or commercial services other than securities services, including
civic/charitable activities and DBA names.

» Requires prior written Compliance approval.

» All new, termed, and amended outside business activities must be submitted electronically through the OBA tool in
ClientWorks.

= Qutside Securities Holdings

» All associates (including Non-Registered) are required to report all outside securities holdings (including immediate family
members) to LPL using the MyComplianceOffice portal in ClientWorks. Menu -> Compliance-> MCO.

» An annual fee of $100 per account with a maximum charge of $200 per personal/family related account.

= Social Media Use

» Take the required training in the Learning Center

» Submit your Social Media Profile through the Social Media Onboarding Form

» Sign up for Social Patrol, a monitoring service



https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/outside-business-activities.html?fromsearch=oba
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/outside-business-activities/how-to-submit-obas-in-cw.html?fromsearch=oba%20tool
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/compliance-resources/outside-business-activities.html?fromsearch=oba
https://rc.lpl.com/content/rc/departments/training-and-education/on-demand-training/on-demand-training.html?fromsearch=learning%20center
https://clientworks.lpl.com/electroniccommunication/socialmedialist
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/getting-started-with-social-patrol.html?fromsearch=social%20patrol

Disclosure

= Marketing Requlatory Review

» All required advertising must be submitted to Marketing Regulatory Review (MRR) via the ART portal (ClientWorks) and
approved for use.

= Business Cards, Letterhead, Stationary, email signatures, office signage

= Seminars

= Radio & television appearances

= Circulars, Newsletters or Fliers

= Statement Inserts

* Prospecting or Direct-Mail communications

= Newspaper Articles and Advertisements

= Telemarketing Scripts

= Form Letters

= Audiovisual communications (audiotapes, videotapes, slides, overheads, etc.)

= Seminar materials, including materials of general interest, intended to educate attendees about basic financial concepts and generic
financial and insurance products.

= Sales Presentation materials (general and non-product specific) used to develop interest in financial planning concepts or insurance
products.

» See the advisor compliance manual for complete list and additional information.



https://rc.lpl.com/content/rc/departments/grc/communications-advertising-compliance.html?fromsearch=marketing%20regulatory%20review
https://rc.lpl.com/content/rc/departments/grc/communications-advertising-compliance.html?fromsearch=marketing%20regulatory%20review
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/manuals/ACM.html?fromsearch=advisor%20compliance%20manual

Disclosure

= The disclosure events set forth in the Form U4 must be reported on an advisor’'s Form U4 promptly.

= Financial disclosures & Liens
» Bankruptcy when it is first filed and when it is discharged.

» Settlements or compromises with creditors (e.g., credit accounts that are settled for less than the full balance, short sales).
» All judgments and liens when they are first filed and when they are satisfied/released (e.g., civil judgments, tax liens).

= Requlatory Disclosure

» Orders, hearings, fines, and investigations from any regulator (e.g., insurance commissioners, state securities or
investment adviser departments).

= Criminal Disclosure
» Charged with or convicted of a misdemeanor involving investments or investment-related business.

» Charged with or convicted of any fraud, false statement, omission, wrongful taking of property, bribery, perjury, forgery,
counterfeiting, extortion, or conspiracy to commit any of these.

» Charged with or convicted of any felony (even if it is not investment related).

= Name and Address Changes
» Required for both personal and business changes.



https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compliance/form-u4-disclosure-information-u4-disclosure&fromsearch=u4
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compliance/form-u4-disclosure-information-u4-disclosure&fromsearch=u4
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/mrr-brokerage-and-advisory-disclosure-guide.html?fromsearch=regulatory%20disclosures
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/mrr-brokerage-and-advisory-disclosure-guide.html?fromsearch=regulatory%20disclosures
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/marketing-regulatory-review0/mrr-brokerage-and-advisory-disclosure-guide.html?fromsearch=regulatory%20disclosures

Disclosure

= Customer Complaints

» All verbal and written customer complaints must be immediately forwarded to the OSJ home office for processing with
LPL’s Legal Department.

» The advisor must provide a written summary of events and all relevant notes and documents.

» LPL Legal will assign an attorney to work with the Institution. All responses must be coordinated with and approved by
Legal. LPL Legal will reply to customer complaints.

» LPL prohibits the advisor or financial institution from settling a customer complaint either written or verbal.

" Private Securities Transactions

» LPL must be provided with written notice of the proposed transaction and whether or not any compensation is involved in
the transaction.

» Participating includes, but is not limited to, making a sale, referring/introducing clients and non-clients to the investment,
issuer or its representative, as well as arranging, facilitating, or participating in meetings and/or discussions between
clients or non-clients and the issuer or their representative.

» Proposed private securities transactions are reported on form PST1.
» Requires written acknowledgement and prior approval from Compliance, Legal & Risk.



https://rc.lpl.com/content/rc/departments/grc/legal/customer-complaint-submission-job-aid.html?fromsearch=customer%20complaints
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/compliance/rule-3280-disclosure-form-associated-persons-private-securities-transactions-and-private-investments-re-pst1&fromsearch=pst1

Account & Documentation

= LPL will sample your annuity, 529, brokered CD, & structured product business, and you will be
cited for not following the required procedures.

= LPL will check for compliance with Reg Bl and Form CRS delivery requirements.

= LPL will confirm that you have completed annual advisory client reviews (F450), and that proper
documentation is on file in ClientWorks.



https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/account-maintenance/advisory-client-review-f450&fromsearch=annual%20advisory%20client%20review
https://rc.lpl.com/content/rc/technology/ACR_HTG.html?fromsearch=annual%20advisory%20client%20review
https://rc.lpl.com/content/rc/technology/ACR_HTG.html?fromsearch=annual%20advisory%20client%20review

Account & Documentation

= Variable Annuities, Fixed Index Annuities & Fixed Annuities
» VA, FIA and FA business is processed through AOE.
> All new policies, exchanges, and sub-pays of $25K or more should be done through AOE.

» All sub-pays below $25K (not from an exchange) should have a corresponding F487 or F439 on file. NEVER submit a VA
or FIA to the carrier without PRIOR LPL approval.

» Carrier paperwork should also be on file in ClientWorks.

= 529 plans
» A 529 College Savings Plan Disclosure Checklist (F423) must be completed for every initial purchase of a 529 plan.

» As of June 18, 2016, the usage of class C share mutual funds in 529 Plans with beneficiaries 12 years of age and younger
is prohibited unless an accommodation can be granted as referenced below.

> The official Statement or Disclosure Document must be delivered to the client.

» The FINRA 529 Expense Analyzer is required for C share transactions of $25K or greater as compared to A share
expenses — signed by client.

» Prospectus delivery and logqing is required.



https://rc.lpl.com/content/rc/departments/products/annuities/aoe.html?fromsearch=aoe
https://rc.lpl.com/content/rc/departments/products/annuities/aoe.html?fromsearch=aoe
https://rc.lpl.com/content/rc/departments/products/annuities/carrier-product-resources.html?fromsearch=carrier%20paperword
https://rc.lpl.com/content/rc/departments/products/annuities/carrier-product-resources.html?fromsearch=carrier%20paperword
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/new-account-opening/account-feature-529-college-savings-plan-disclosure-checklist-f423&fromsearch=f423
https://www.finra.org/investors/tools-and-calculators/using-finra-fund-analyzer
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=securities%20reciept%20log
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=securities%20reciept%20log

Account & Documentation

= Brokered CDs

» The Brokered CD Disclosure Statement must be delivered to client at or prior to sale and Advisor attestation is required at
the time of order entry.

» Form F463 has been retired and is no longer required.

» Structured Products
» Preliminary prospectuses for structured products are REQUIRED to be sent to clients prior to purchase.
» LPL DOES NOT send preliminary prospectuses for structured products on the rep’s behalf.

» Reps must use the F631 or other similar method to document delivery of preliminary prospectuses for Structured Products.
Audit will look for this if you do Structured Products. See the Prospectus FAQ in the Resource Center for prospectus record
keeping requirements.

» October update to concentration limits- Aggregate concentration exceeding 30% of LNW may be subject to additional best
interest/suitability review.



https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/cash-management/prospectus-delivery-log-f631&fromsearch=f631
https://rc.lpl.com/content/rc/help-center/account-maintenance-hub/how-to-fix.html?fragmentId=/content/dam/content-hub/stage/content-fragments/account-maintenance/automated-and-electronic-prospectus-delivery-faq&fromsearch=prospectus+faq

Account & Documentation

= Cryptocurrency

» Advisors & their OSJ/RIA supervisors must complete the required one-time Cryptocurrency-Related Products training
located within the Learning Center.

» Your clients must complete the Cryptocurrency-Related Products Acknowledgement form (E725) for each account in which
the product will be purchased. (This form must be signed via eSignature).

» LPL does not facilitate any currency trading. Advisors cannot recommend the purchase, sale, or custody of actual
cryptocurrency through LPL.

» Advisors cannot participate in cryptocurrency mining.

» Advisors can, at their own risk, purchase actual cryptocurrencies for their own accounts at approved outside broker-dealer
firms that support virtual currency trading.



https://rc.lpl.com/content/rc/departments/grc/cryptocurrency-faq.html?fromsearch=cryptocurrency%20policy
https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/knowledge-article/invest-and-trade/complex-exchange-traded-product-acknowledgment-form-f725&fromsearch=f725

Regulation Enforcement

= Reg Bl & Form CRS:
» Effective on June 30, 2020
» Established Best Interest Standard
» Applies to any recommendation

» Client above self
» Establishing and enforcing adequate written supervisory procedures (\WWSPs)

» Form CRS, a brief relationship summary that discloses material information about the firm in plain language (e.g.,
investment services provided, fees, conflicts of interest, legal and disciplinary history of the firms and financial
professionals).

> Delivery and Logging

» FINRA will continue to share further findings as they continue to conduct exams and gather additional
information on member firms’ practices.



https://rc.lpl.com/content/rc/mega-menu/best-interest-standard/sec-info-center.html?fromsearch=reg%20bi
https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=form%20crs
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/manuals/written-supervisory-procedures.html?fromsearch=wsp
https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=crs
https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=crs
https://rc.lpl.com/content/rc/DOL/form-crs-delivery-triggers.html?fromsearch=crs%20delivery
https://rc.lpl.com/content/rc/DOL/form-crs-delivery-triggers.html?fromsearch=crs%20delivery
https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=crs%20logging

REG Bl Enforcement

FINRA/SEC Focus for 2025
1000 minimal REG BI Audits

Best interest rationale documentation

AQOE Orders — Reasonably available alternatives
Advisory Reviews — Fiduciary obligation, written into the Act.

Form CRS delivery and logging

Quarterly reporting now from LPL

Accounts opened vs CRS deliveries logged



https://rc.lpl.com/content/rc/DOL/documenting-best-interest-recommendations.html?fromsearch=account%20and%20transaction%20documentation
https://rc.lpl.com/content/rc/DOL/documenting-best-interest-recommendations.html?fromsearch=account%20and%20transaction%20documentation
https://rc.lpl.com/content/rc/DOL/form-crs-decision-tree.html?fromsearch=crs%20logging
https://rc.lpl.com/content/rc/DOL/form-crs-decision-tree.html?fromsearch=crs%20logging

Account & Documentation

= Reg Bl & Form CRS

» Broker-dealers and RIAs are required to deliver a two to four page Relationship Summary (Form CRS) to new and existing
advisory and brokerage customers.

» Existing Clients must receive form CRS when recommending opening a new account that is different from the retail
investor’s existing account(s); or when recommending or providing a materially new brokerage service or investment.

» Prospects/New Clients must get delivery prior to a recommendation of an account type, a securities transaction, or an
investment strategy.

= CRS Delivery Methods & Logging

» By hand. Available in Resource Center. Log delivery in ClientWorks application.

» By mail (Requires 5 day wait prior to making a recommendation). Requested and automatically logged through ClientWorks
application.

» Electronically via email. Requested and automatically logged through ClientWorks application.
» LPL will redeliver if material changes are made to CRS.
» Most recent version of Form CRS is available in the Resource Center.



https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=crs
https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=crs
https://rc.lpl.com/content/rc/DOL/form-crs-decision-tree.html?fromsearch=crs%20logging
https://rc.lpl.com/content/rc/DOL/relationship-summary-form-crs.html?fromsearch=crs

ccount & Documentation

CRS Logging Tool:

ClientWorks - Form CRS - Customer Relationship Summary &, Jean Elzayek |LogOut (@ On-the-Go

0S.J Review Tool

0 The Relationship Summary must be delivered prior to (1) any recommendation regarding account type, a securities transaction, or an investment strateqy involving securities, or (2) any account opening. Use this tool to deliver prior to any recommendation. New accoun
opening.
Please note that information for existing clients CANNOT be updated using the fields below. To update a client profile, please follow existing LPL procedures.

Trade Blotter

Investment Product Switch

Type of Recipient Outside Business Activity

Note that a "Client” must have an LPL-issued account number. If the recipient has no LPL-issued account number (even if account opening paperwork is currently being processed), click "Prospect” below. Communication
If a "Client” is not found in Client Search, please select "Prospect” and input the "Client” information (Example : Secondary Account holders) to send FORM CRS

Direct Business / Branch Trade Report

Proactive Surveillance

Deli Option * Client Search
elven opren ComplianceMax

Select - Min 3 Characters required -

RegEd Xchange
First Name * Last Name * Rep D * Email address ~ SMartPros/BEMS/AQ
- Social Media/Electronic Communications
Recommendation Rationale

Country Search US Address Street 1 Street 2
Form CRS +

United States -

City State Zip code




Account & Documentation

= Annual Client Contact

» If you have advisory accounts, the SEC mandates that you meet with your clients no less than annually to perform a
complete portfolio review, re-confirm account objectives, etc.

» Annual review meeting can be held virtually, via phone, or in person.
» Annual Client Review forms (F450) is located in the 'Clients' sub-menu within the Client Management page of ClientWorks.

» All substantial client reviews are REQUIRED to be documented in ClientWorks. This includes OMP, SAM, MWP, PWP and
Manager Select. LPL audit will demand records of your documented annual reviews. If they are not in ClientWorks, you will
be cited.

» The Annual Client Review form covers many of the topics that should be reviewed while performing a client review in
addition to a general comments section for general information material to the client's circumstances.

» Under the “Clients” tab in ClientWorks, you can use the “Last Review Date” column to sort filter or create quick views to see
which client reviews are due.

» Please see the Annual Client Review Meeting Policy page of the Resource Center for additional information on completing
Annual Client Review forms in ClientWorks.



https://rc.lpl.com/content/rc/help-center/content-details.html?fragmentId=/content/dam/content-hub/content-fragments/account-task/account-maintenance/advisory-client-review-f450&fromsearch=f450
https://rc.lpl.com/content/rc/technology/CW-client-management.html?fromsearch=client%20management%20page
https://rc.lpl.com/content/rc/departments/grc/advisory-compliance-/retirement-plan-consulting-program--rpcp--/annual-client-meeting-policy-.html?fromsearch=annual%20client%20review%20meeting%20policy

Account & Documentation

Annual Advisory Review (F450)

ChenmtWorks -

ient Management Ener Trade | Create Mew Accoun & Lindsey Bessant | Log Oux Onthe-Go @1 O
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Account &

Documentation

Annual Advisory Review (F450)

Advisory Client Review (F450)

« Client Meeting and Explanation

olnvestmem Advisor Representatives |ARs are required to perform a substantial review with each advisory client as defined by tax ID at least annually (one
review every 12 months). This electronic form is used to document ongoing investment advice with clients regarding their advisory account(s) for the annual

review requirement.

0 Instructions: Please identify topics reviewed with the client by marking the boxes below. If changes were made or proposed as part of the review, please select
“Reviewed and changes made or proposed” and provide a detailed explanation of the changes made or proposed, along with any other meeting details or

recommendations made.

v Completed: ® InPerson

ved Financial Status ® Did not review
® Did not review
® Did not review

5 ® Did not review

1t Holdings @ pid not review
Reviewed Investment Performance (® Did not review

Advisory Account Fees (SAM I/1l & level of trade activ_ (@ pid not review

) Email

O Phone O video Conference ) CRM Exists

() Reviewed and no change
) Reviewed and no cha nge
O Reviewed and no cha nge

() Reviewed and no change

) Reviewed and no change

O Reviewed and no change

() Reviewed and no change

() Reviewed and changes made or proposed
) Reviewed and changes made or proposed

 reviewed and changes made or proposed

) Reviewed and changes made or proposed

) Reviewed and changes made or proposed

) Reviewed and changes made or proposed

() Reviewed and changes made or proposed

Save as Draft




Products

= Complex Products and Options

» Communications and Disclosures — Truthful, Transparent, Best Interest
» Examinations of firms’ crypto asset retail communications

» Option Account Approvals - Risks related to supervising the approval of options accounts (both self-directed and full-
service brokerage accounts) and monitoring the trading activity in options accounts.

= Variable Annuities

» Rules apply when recommending a purchase, surrender, exchange, or additional deposit (sub-pay) of a deferred variable
annuity to a retail customer

» Surveillance for pattern recognition

» Establish thresholds

» Data confirmation with carriers for fees and benefits gained/lost
» Client Disclosures

» Best interest rationale

» Reasonable alternatives

» Buyout offers



https://rc.lpl.com/content/rc/departments/grc/product-supervision-/complex-products.html?fromsearch=complex%20products%20disclosures

Best Practices

= Manipulative Trading
» Front Running/Trading Ahead
» Block Transactions

= Trusted Contact Persons
» Take care of the most vulnerable
» Does not have to be a senior
» Exploitation or diminished capacity
» Establish trusted contact/POA/Trustee, etc.
» Cannot be the rep (includes being a bene)
» Can place a temporary hold on instructions

= Cybersecurity

» Cybersecurity threats continue to be one of the most significant risks many customers and member firms face. The frequency,
sophistication and variety of attacks continue to increase.

» Customer account intrusions

» Ransomware attacks

Cyber-enabled fraud

Fraudulent ACATs

In August 2022, FINRA established the Cyber and Analytics Unit (CAU)

Y VY

v



https://rc.lpl.com/content/rc/departments/technology/reference-center/Enhanced_Trading_Reference_Center/merge-blocks-trading-ahead.html?fromsearch=block%20trades
https://rc.lpl.com/content/rc/departments/technology/reference-center/Enhanced_Trading_Reference_Center/merge-blocks-trading-ahead.html?fromsearch=block%20trades
https://rc.lpl.com/content/rc/departments/grc/seniorinvestors/new-trusted-contact-policy-effective-feb5-2018.html?fromsearch=trusted%20contact%20policy%20faq
https://rc.lpl.com/content/rc/departments/grc/seniorinvestors/senior-investor-protection-policy.html?fromsearch=senior%20investor%20protection%20(sip)
https://rc.lpl.com/content/rc/departments/grc/seniorinvestors/senior-investor-protection-policy.html?fromsearch=senior%20investor%20protection%20(sip)
https://rc.lpl.com/content/rc/mega-menu/technology/tech-solution-center/advisor-information-security.html?fromsearch=cyber%20security

Continuing Education

- FINRA — New Process
- Applies to anyone who holds a FINRA License
- Now required annually
- Must go to www.FINRA.org and use/(re)establish a FINPRO account
= 12 hours of CE courses are already assigned to each of you
- FINRA has begun sending notifications directly
= 12/31 Due Date
- Failure to complete means you are suspended for new year (no renewals) until CE is done
- LPL may help notify, but that is all they can do
- NO EXCEPTIONS
- Firm Element
Applies to all licensed persons at LPL
Usual LPL process rolls out in Q3 with a 10/31 Due Date
Courses will include: Annual Compliance Meeting, AML, Security and Privacy, IS Training (if applicable), and possibly 1
or 2 other timely topics.
You will receive full notifications/warnings from LPL and the OSJ
Annual Questionnaire — Applicable to any person affiliated with LPL in any manner
- Certifications
Certifications (CFP, CPA, etc.) — Check with your certification boards/websites for their maintenance/CE requirements.
Check your Advisor Profiles via Advisor Compliance Tool in CW.

Check on any outstanding requirements: ClientWorks -> Menu -> Tools -> Learning Center



http://www.finra.org/

Continuing Education

Adwsory (NASAA) — New Requirements

Applies to anyone who holds an Advisory license
Certain states now require additional advisory continuing education — AR, CO, CA, FL, Hi, KY, MD, MI, MS, NV, ND,
OK, OR, SC, TN, VT, DC, WI.
If you are registered in one of these 16 states, you will personally need to find a CE provider and take your State’s
prescribed CE courses.
For a list of affected States and helpful resources go to: ClientWorks -> Resource Center: IAR Continuing Education.
Check with www.NASAA.ORG for general info
For State specifics and a list of acceptable CE providers - https://www.nasaa.org/industry-resources/approved-iar-ce-
providers/
Check with your individual State Securities Commissions
Check your Advisor Profiles via the Advisor Compliance Tool in CW
LPL may notify only, but just like with FINRA CE, that is all they can do
Some reciprocity is given for certain courses taken at the BD. To apply your FINRA Regulatory Element CE to the 6-
hour Products and Placements requirement for IAR CE, you will click the “Apply Regulatory Element” link in FinPro,
and then follow the prompts to pay the $18 fee.

- Insurance
Applies to anyone who holds Insurance licenses
Check your State insurance CE requirements via NIPR website: www.nipr.com
Your State Insurance Commission is another good place for insurance information specific to your state.
Check your Advisor Profiles via Advisor Compliance Tool in CW.



http://www.nasaa.org/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
https://www.nasaa.org/industry-resources/approved-iar-ce-providers/
http://www.nipr.com/

Additional Resources

*Branch Exam Preparation Checklist

=2025 LPL Branch Exam Priorities

=Audit Prep Portal



https://rc.lpl.com/content/dam/rc/documents-new/clr/compliance/branch-exams/branch-exam-preparation-checklist.pdf
https://rc.lpl.com/content/dam/rc/documents-new/clr/compliance/branch-exams/branch-exam-preparation-checklist.pdf
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-exam-priorities.html
https://rc.lpl.com/content/rc/departments/grc/compliance-essentials/branch-exam-priorities.html
https://financialresourcesgroup.net/advisor-resources/complianceresources/compliancedocs/onboarding-and-office-setup-overview/
https://financialresourcesgroup.net/advisor-resources/complianceresources/compliancedocs/onboarding-and-office-setup-overview/

Team

T

David Rich
Chief Compliance Officer
(704) 816-8006
david.s.rich@Ipl.com

Warren Williams

LPL Senior Compliance &

Supervisory Analyst
(704) 816-8012

warren.c.williams@lpl.com

Jim Liddington
Senior Compliance &
Supervisory Analyst
(704) 816-8016
jim.liddington@]pl.com

Jeffrey Orlouski
Compliance & Supervisory
Analyst
(704) 816-8036
jeffrey.orlouski@lpl.com

Lindsey Bessant
Senior Compliance &
Supervisory Analyst
(704) 816-8021
lindsey.bessant@lpl.com

Lacie Witherspoon
Compliance & Supervisory
Analyst
(704) 816-8048

lacie.witherspoon@lpl.com

Chris Zehetmaier
Senior Compliance &
Supervisory Analyst
(704) 816-8041
chris.zehetmaier@]pl.com
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